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DEPARTMENT OF COMPUTER SCIENCE 
 

 

Vision 

1. To demonstrate proficiency in problem-solving techniques using the computer. 

2. To demonstrate proficiency in at least two high-level programming languages and two 

3. Operating systems 

4. To show the ability to analyze a problem, and identify and define the computing 

requirements appropriate to its solution. 

5. To show the ability to function effectively on teams to accomplish a commongoal. 

6. To sensitize the students to the social realities around them with the vision of making them 

responsiblecitizen. 

Mission 

To provide a high-quality undergraduate education in computer science that prepares 

students for productive careers and lifelong learning. 

 

Programme Educational Objectives (PEOs) 
 

PEO -1 The graduates will apply appropriate theory and scientific knowledge to participate 
in activities that support humanity and economic development nationally and 
globally, developing as leaders in their fields of expertise. 

PEO - 2 The graduates pursue lifelong learning and continuous improvement of 
The knowledge and skills with the highest professional and ethical standards. 

PEO - 3 The graduates are trained to be employed in IT industries by providing 
domain knowledge, career and entrepreneurial skills. 

 

Programme Outcomes (POs) 
 

POs 
Upon completion of B.Sc. Computer Science programme, the graduates will 
be able to: 

PO - 1 utilize scientific knowledge to pursue higher studies in the relevant field. 

PO - 2 
create innovative ideas to enhance entrepreneurial skills for economic 
independence. 

PO – 3 face challenging competitive examinations that offer rewarding careers. 

PO – 4 
reflect upon green initiatives and take responsible steps to build a sustainable 
environment. 

PO – 5 handle ethical issues with social responsibility. 

PO – 6 
communicate effectively and collaborate successfully with peers to become 
competent professionals. 



Programme Specific Outcomes (PSOs) 

 

PSOs Upon completion of the B.Sc. Degree Programme, the graduates will 
be able to: 

PSO – 1 acquire the domain knowledge with critical thinking to serve the 
technical society as software engineer, data analyst and designing 
professional. 

PSO - 2 enrich the managerial skills through team building and 
social responsibility. 

PSO – 3 enhance the communication skills with lifelong learning. 

PSO - 4 apply modern techniques to sustain the ever-changing era with values. 

 

Eligibility Norms for Admission 

Those who seek admission to B.Sc. Computer Science must have passed the Higher 

Secondary Examinations conducted by the Board of Higher Secondary Examination, Tamil Nadu 

with Computer Science or Mathematics as one of the subjects or any other examination recognized 

and approved by the Syndicate of the Manonmaniam Sundaranar University, Tirunelveli. 

Duration of the Programme:3 years 

Medium of Instruction: English 

Passing Minimum 

A minimum of 40% in the external examination and an aggregate of 40% is required. 

There is no minimum pass mark for the Continuous Internal Assessment. 

Components of the B.Sc. Computer Science Programme 

Part III (Major and Allied) 

 

 
 

Major 

Core – Theory papers 12 x100 1200 

Practicals (Core applied) 9 x100 900 

Elective - Theory papers 3 x 100 300 

Project  100 

Total marks  2500 

 
 

Allied (I & II) 

Theory 4x100 400 

Total marks 
 

400 

 

Part III - Total marks 

 
2900 



Course Structure 
Distribution of Hours and Credits 

 
Course Sem. I Sem. II Sem. III Sem. IV Sem. V Sem.VI Total 

Hours Credits 

Part I–Language 6 (4) 6 (4) - - - - 12 8 

Part II-English 6 (4) 6 (4) - - - - 12 8 

Part-III 

Major Core -  Theory 
 

4(4) 

 

4(4) 

5(4)+ 
5(4)+ 
5(4) 

5(5) + 

5(5) 

6(5) + 

5(5) 

5(5)+ 
5(5)+ 
5(5) 

59 55 

Major Core -Practical 
4(2) 4(2) 

4(2) 
4(2) 

4(2) 
4(2) 

6(3) 4(2) 
4(2) 

38 19 

Elective - - - 5(4) 5(4) 5(4) 15 12 

Project - - - - 6(6)  6 6 

Allied- Theory 4(3) 4(3) 5(3) 5(3) - - 18 12 

Part IV 

Add on 

Course(Professional 

English) 

2(2) 2(2) 2 (2) 2 (2) - - 8 8 

Non-Major Elective 2 (2) 2 (2) - - - - 4 4 

SEC(Skill 

Enhancement Course) 

2 (2) 2 (2) - -  2 (2) 6 6 

AEC(Ability 

Enhancement Course) 

    2(2)  2 2 

Total 30(23) 30(23) 30(21) 30(23) 30(25) 30(25) 180 140 

 
Non Academic Courses 

Part V 

FC –I(Values for 

Life) 

- (1) - - - - - 1 



         

FC– II(Personality 

Development) 

- - -  

(1) 

- - - 1 

FC–III (Human 

Rights Education) 

- - - - (1) - - 1 

FC –IV (Gender 

Equity Studies) 

- - - - - (1) - 1 

SLP-Community 

Engagement Course 

- - (2) - - - - 2 

SLP-Extension 

activity (RUN) 

  
- (2) 

   
2 

STP - Clubs & 

Committees / NSS 

- - - (2) - - - 2 

 

Total number of hours = 180 

Total number of credits = 140+10 
 

Non Academic Courses are Mandatory and conducted outside the regular working hours 

Skill Development Programme (Mandatory Certificate Course- 60 hours) will be offered in 

the first year for all the students. 



Courses Offered 
 

 
Semester 

 
Course 

Course 

Code 
Title of the Course 

Hours 

/ Week 

 

Credits 

 

 

 

 

 

 
I 

Part I TL2012/ 

FL2111 

Language: Tamil/French 6 4 

Part II GE2013 General English 6 4 

 

Part III 

SC2011 Major Core I: Programming Concepts in C 4 4 

SC20P1 Major Practical I: C Programming 4 2 

SA2011 Allied I: Theory: Digital Principles and Applications 4 3 

 
 

Part IV 

APS201 Add on Course: Professional English for Physical 

Sciences - I 

2 2 

SNM201 Non Major Elective (NME): Internet and Web 

Designing with HTML 

2 2 

SEC201 / 

SEC202 

Skill Enhancement Course (SEC): Meditation and 

Exercise / ComputerLiteracy 

2 2 

 
Part V 

FCV201 Foundation Course I: Values for Life - - 

STP201 Student Training Programme (STP): 

Clubs & Committees / NSS 

- - 

 

 

 

 

 

 

 
II 

Part I TL2021/ 

FL2121 

Language: Tamil/French 6 4 

Part II GE2023 General English 6 4 

 

Part III 

SC2021 Major Core II: Object Oriented Programming Using 

C++ 

4 4 

SC20P2 Major Practical II: C++ Programming 4 2 

SA2021 Allied II: Theory: Computer Organization and 

Architecture 

4 3 

 
 

Part IV 

APS202 Add on Course: Professional English for Physical 

Sciences – II 

2 2 

SNM202 Non Major Elective (NME): Desktop Publishing 

using Scribus 

2 2 

SEC201 / 

SEC202 

Skill Enhancement Course (SEC): Meditation and 

Exercise / Computer Literacy 

2 2 

 

Part V 

FCV201 Foundation Course I: Values for Life - 1 

SLP201 Service Learning Programme: Community 

Engagement Course 

  

STP201 Student Training Programme (STP): Clubs & 

Committees / NSS 

- - 

 

 

 

 

 

 

 

 
III 

 

 
 

Part III 

SC2031 Major Core III: Programming in Java 5 4 

SC2032 Major Core IV: Data Structures and Algorithms 5 4 

SC2033 Major Core V: Computer Networks 5 4 

SC20P3 Major Practical III: Java Programming 4 2 

SC20P4 Major Practical IV: Data Structure Using C++ 4 2 

SA2031 Allied III: Theory: Numerical and Statistical Methods 5 3 

Part IV APS203 Add on Course: Professional English for Physical 

Sciences 

2 2 

 
 

Part V 

FCV202 Foundation Course II: Personality Development - - 

STP201 Student Training Programme (STP): Clubs & 

Committees / NSS 

- - 

SLP201 Service Learning Programme (SLP):Community 

Engagement Course 

- 2 



  SLP202 Service Learning Programme (SLP): 

Extension Activity (RUN) 

- - 

 

 

 

 

 

 

 

 
IV 

 

 

 

 

Part III 

SC2041 Major Core VI: UNIX and Shell Programming 5 5 

SC2042 
Major Core VII: Relational Database Management 
Systems 

5 5 

 

SC2043 
SC2044 
SC2045 

Elective I: 

(a) Software Engineering 
(b) System Administration and Maintenance 
(c) Software Testing 

 

 
5 

 

 
4 

SC20P5 Major Practical V: Shell Programming 4 2 

SC20P6 Major Practical VI: SQL and PLSQL 4 2 

SA2041 Allied IV: Theory: Discrete Mathematics 5 3 

Part IV APS204 Add on Course: Professional English for Physical 
sciences 

2 2 

 
Part V 

FCV202 Foundation Course II: Personality Development - 1 

SLP202 
Service Learning Programme (SLP) Extension 
Activity (RUN) 

  

STP201 
Student Training Programme (STP): Clubs & 
Committees / NSS 

- 2 

 

 

 

 

 
V 

 

 

 

Part III 

SC2051 Major Core VIII: Web Technology: Theory and Practice 6 5 

SC2052 Major Core IX: Mobile Computing and its Applications 5 5 

 

SC2053 

SC2054 

SC2055 

Elective II: 

(a) Multimedia Systems 

(b) Microprocessor & Assembly 

Language Programming 
(c) Open Source Technology 

 
 

5 

 
 

4 

SC20P7 Major Practical VII: Web Technology Lab 6 3 

SC20PR Project 6 6 

Part IV 
AEC201 

Ability Enhancement Course (AEC): 
Environmental Studies 

2 2 

Part V FCV203 Foundation Course III: Human Rights Education 
- 1 

 

 

 

 

 

 

VI 

 

 

 
 

Part III 

SC2061 Major Core X: Android Programming 5 5 

SC2062 Major Core XI: Computer Graphics 5 5 

SC2063 Major Core XII: Operating Systems: Design Principles 5 5 

 

SC2064 

SC2065 

SC2066 

Elective III 

(a) PHP Programming 
(b) Network Security 
(c) E-Commerce Technologies 

 
 

5 

 
 

4 

SC20P8 Major Practical VIII: Android Programming Lab 4 2 

SC20P9 Major Practical IX: Computer Graphics Lab 4 2 

Part IV 
SSK206 Skill Enhancement Course (*SEC): Photoshop CS6 2 2 

Part V FCV204 Foundation Course IV: Gender Equity Studies (GES) - 1 

   TOTAL 180 140+ 

10 



*SBC for the VI semester is offered by the departments for their students 

SBC - We offer PHP Programming during VI semester. The objective of this SBC is to 

develop webpage. 

NMEC – We offer Internet and Web Designing with HTML and Desktop Publishing 

using Scribus during I and II semester. The objective of Internet and Web Designing with HTML 

is to design webpage and browse in internet and Desktop Publishing using Scribus to design and 

create magazines, newsletter, brouchers etc and to easily produce stylised documents. Project – 

We offer project in V semester. The aim is to equip the students to develop real time projects. 

Self-Learning – Extra Credit Courses 

 

Semester Course Code Title of the Course Hours / 

Week 

Credits 

III SC20S1 Web Designing with HTML - 2 

IV SC20S2 Maya - 2 

 

Value Added Courses 
 

Semester Course Code Title of the course Total hours 

I VASC201 DCA-I 30 

II VASC202 DCA-II 30 

 
Instruction for Course Transaction 

Distribution of total hours for Theory (Major Core) 

Components Sem I Sem II Sem III Sem IV Sem V Sem 

VI 

Lecture Hours 45 45 60 60 75/60 60 

Continuous Internal 

Assesment (2) 

5 5 5 5 5 5 

Quiz(2) 1 1 1 1 1 1 

Class test(3) 3 3 3 3 3 3 

* Class assignment/Group 

discussion/ Problem 

Solving(any other) 

 
6 

 
6 

 
6 

 
6 

 
6 

 
6 

Total Hours 60 60 75 75 90/75 75 



Distribution of total hours for Theory (Elective / Allied) 

Components Elective Allied 

Sem IV Sem V Sem VI Sem I Sem II Sem III Sem IV 

Lecture Hours 60 60 60 45 45 60 60 

Continuous Internal 

Assesment (2) 

5 5 5 5 5 5 5 

Quiz(2) 1 1 1 1 1 5 1 

Class test(3) 3 3 3 3 3  3 

* Class assignment/Group 

discussion/ Problem 

Solving(any other) 

 
 

6 

 
 

6 

 
 

6 

 
 

6 

 
 

6 

 
 

6 

 
 

6 

Total Hours 75 75 75 60 60 75 75 

 
Distribution of total hours for Practical 

 

 

 

 
Major 

Semester Hours / Week Total Hours / 

Semester 

I /II 4/4 120 

III / IV 4/4 120 

V 6 90 

VI 4/4 120 



Examination Pattern Ratio of Internal and External Components 

 

Each paper carries an internal component. • 

There is a passing minimum for external component. 

A minimum of 40% in the external examination and an aggregate of 40% is required. 

 
i) a. Part I - Tamil 

Ratio of Internal and External= 30:70 

Continuous Internal Assessment (CIA) 
Internal Components and Distribution of Marks 

 

Components Marks 

Internal test (2) 15 

Quiz (2) 4 

Class Test (2) 6 

Class assignment/ Home assignment/ Field assignment/ Article 

review/ Group discussion/ Problem solving 

5 

Total 30 

 

Question Pattern 
 

Internal Test Marks External Exam Marks 

Part A 4 x 1 4 Part A 10 x 1 (No choice) 10 

Part B 3 x 4 12 Part B 5 x 4 (Internal choice) 20 

Part C 3 x 8 24 Part C 5 x 8 (Internal choice) 40 

Total 40 Total 70 

 
b. Part I -French 

Ratio of Internal and External= 30:70 

 

Continuous Internal Assessment (CIA) 
Internal Components and Distribution of Marks 

 

Components Marks 

Internal test (2) 15 

Quiz (2) 4 

Class Test (2) 6 

Class assignment/ Home assignment/ Field assignment/ Article 

review/ Group discussion/ Problem solving 

5 

Total 30 

 

Question Pattern for I & II Semesters 
 

Internal Test Marks External Exam Marks 

Part A (Translation) 5 Part A (Translation) 4x5 20 

Part B (Grammar) 5x5 25 Part B (Grammar) 6x5 

(Paragraph Writing) 15x1 

30 



Part C (Paragraph 

Writing)10x1 

10 Part C (Translation, Comprehension) 

2x5 

 

10 

  Part D 5x2 10 

Total 40 Total 70 
 

ii) Part II - General English 

Ratio of Internal and External= 30:70 

 
Continuous Internal Assessment (CIA) 

Internal Components and Distribution of Marks 

 

Components Marks 

Internal test (2) 15 

Quiz (2) 4 

Class Test (3) 6 

GD/Open Book Test/Role Play/Assignment/Article 

Review/Seminar 
5 

Total 30 

 

Question Pattern 
Internal Test Marks External Exam Marks 

Part A (Objective Type) 4 x 1 = 4 Part A (Objective Type) 10 x 1 = 10 

Part B 3 x 4 = 12 Part B 5 x 4 = 20 

Part C 3 x 8 = 24 Part C 5 x 8 = 40 

Total 40 Total 70 

 

iii) Part III (Major/ Elective/ Allied) 

Ratio of Internal and External= 30:70 

 

Continuous Internal Assessment (CIA) 
Internal Components and Distribution of Marks 

 

Internal Components Marks 

Internal test (2) 15 

Quiz (2) 4 

Class test (3) 6 

Open Book Test/ Home 

assignment / Class Assignment/ 

Group Discussion 

5 

Total 30 



Question Pattern 
 

Internal Test Marks External Exam Marks 

Part A 4 x 1 4 Part A 10 x 1 (No choice) 10 

Part B 3 x 4 12 Part B 5 x 4  (Internal choice) 20 

Part C 3 x 8 24 Part C 5 x 8  (Internal choice) 40 

Total 40 Total 70 

 
 

Practicals : Major Core & Allied papers 

Ratio of Internal and External= 40:60 

Total: 100 marks 

Internal Components and Distribution of Marks 
 

Internal Components Marks 

Performance of the Experiments 10 

Regularity in attending practical and submission of records 10 

Record 5 

Model exam 15 

Total 40 

 

Question pattern 
 

External Exam Marks 

Major Practical 
60 

Minor Practical / Spotters /Record 

Total 60 

 
iv) Part IV 

Ratio of Internal and External = 50: 50 

a) Add-on Course: Professional English for Physical Sciences 

Internal Components and Distribution of Marks 
 

Internal Components Marks 

Listening and speaking 25 

Reading and Writing 25 

Total 50 

 

Question pattern 
 

External Exam Marks 

Written Test : Open choice – 5 out of 7 questions (5 x 10) 50 

Total 50 



b) Non – Major Elective (NME) 

Continuous Internal Assessment (CIA) 
Internal Components and Distribution of Marks 

 

Internal Components Marks 

Internal test (2) 20 

Quiz (2) 15 

Class assignment/ Home assignment/ Project report 15 

Total 50 

 
Question Pattern 

 

Internal Test Marks External Exam Marks 

Part A 4 x 1 

(No Choice) 

4 Part A 5 x 1 

(No Choice) 

5 

Part B 3 x 4 
(Internal Choice) 

12 Part B 5 x 3 
(Internal Choice) 

15 

Part C 3 x 8 

(Internal Choice) 

24 Part C 5 x 6 

(Internal Choice) 

30 

Total 40 Total 50 

 
 

c) Skill Enhancement Course (SEC) - Computer Literacy 

Internal Components 
 

Component Marks 

Objective type questions (30x1) 30 

Exercise (Book) compulsory (2x10) 20 

Total 50 

 

External Components 
 

Component Marks 

Exercise 1 20 

Exercise 2 10 

Procedures for both Exercises 20 

Total 50 

 
d) Skill Enhancement Course (SEC) - Meditation and Exercise 

Internal Components 
 

Component Marks 

Objective type questions (20x1) 20 

Exercise (2x10) 20 

Assignment 10 

Total 50 



External Components 
 

Component Marks 

Quiz 20 

Written test : Open choice –10 out of 15 questions (10x3) 30 

Total 50 

 
 

e) Ability Enhancement Course (AEC) - Environmental Studies 

Internal Components 
 

Component Marks 

Project Report 30 

Viva voce 20 

Total 50 

 

 
External Components 

 

Component Marks 

Quiz 20 

Written Test : Open choice – 10 out of 15 questions (10x3) 30 

Total 50 

 
v) Part V 

i) Foundation course (Values for life, Personality development, Human rights 

education and Gender equity studies) 

Ratio of Internal and External = 50: 50 

 
 

a) Foundation Course I: Values for Life 

Internal Components 

Component Marks 

Song, Mime, Skit 20 

Book Activities 20 

A Kind Action 10 

Total 50 

External Components 

Component Marks 

Quiz 20 

Written Test : Open choice – 5 out of 7 questions (5 x 6) 30 

Total 50 



b) Foundation Course II: Personality Development 

Internal Components 

Component Marks 

Exercise from book 20 

Skit 10 

Group Album 20 

Total 50 

 

External Components 

Component Marks 

Quiz 20 

Written Test : Open choice – 5 out of 7 questions (5 x 6) 30 

Total 50 

 

c) Foundation Course III: Human Rights Education 

Internal Components 

Component Marks 

Album on current issues 20 

Group Song/ Mime/ Skit 10 

Open book test (Objective type questions) 20 

Total 50 

External Components 

Component Marks 

Quiz 20 

Written Test : Open choice – 5 out of 7 questions (5 x 6) 30 

Total 50 

d) Foundation Course IV: Gender Equity Studies 

Internal Components 

Component Marks 

Album on current issues 20 

Group Song/ Mime/ Skit 10 

Open book test (Objective type questions) 20 

Total 50 

External Components 

Component Marks 

Quiz 20 

Written Test : Open choice – 5 out of 7 questions (5 x 6) 30 

Total 50 



e) SLP -Community Engagement Course (CEC) 

(Field Work – 15 hrs; Class Hours – 15 hrs) 

Internal Components 

Component Marks 

Assignment 10 

Group Discussion 10 

Attendance (Field work) 30 

Total 50 

External Components 

Component Marks 

Project Report / Case Study (10-15 pages in print) 

Group project 

50 

Total 50 

f) SLP – Service Learning Programme: Reaching the Unreached Neighbourhood (RUN) 

• 60 Hours mandatory programme included in the curriculum (2 credits). 

 
g) STP – Student Training Programme 

• Compulsory for all I &II year students (2 credits). 

• Clubs and Committees – Eco Club, YRC, Rotaract Club, NSS/ RRC, 

AICUF, Consumer Club, Sports, Legal Literacy and Women’s Cell. 

• Each student can opt for one club/ commit 

 

 

Semester I 

NME: Internet and Web Designing with HTML 

Course Code: SNM201 

 

No. of Hours per 
Week 

Credits 
Total No. of 

Hours 
Marks 

2 2 30 100 

Objectives: 

1. To enable the students to specify design rules in constructing web pages andsites. 

2. To enable the students to learn the basic working scheme of the Internet and World Wide Web. 



 
 

 

 

Course Outcome 
 

CO Upon completion of this course the students will be able 

to: 

PSO 

Addressed 
CL 

CO - 1 analyze a web page and identify its elements and attributes. PSO-1 AN 

CO - 2 
design web pages using DHTML and Cascading Style 
Sheets. 

PSO-2 C 

CO - 3 design and construct web sites. PSO-4 C 

CO – 4 create e-mail ID and browse in internet. PSO-4 AP, C 
 

Unit I 

Introduction to Internet: Internet –World Wide Web - Web Browsers. E-mail: E-mail - 

Creating an E-mail id - Sending and Receiving mails – Attaching a File – Functions of e-mail – 

Advantages and Disadvantages of e-mail. 

Unit II 

Introduction to HTML: Designing a Home Page - HTML Documents - Anchor Tag. 

Head and Body Section: Colorful Web Page. Designing the Body Section: Horizontal Rule – 

Aligning the Headings - Image and Pictures. 

Unit III 

Ordered and Unordered lists: List - Unordered lists - Ordered Lists - Nested Lists. Table 

Handling: Tables - Table Creation in HTML - Cells Spanning Multiple Rows/ Columns - Coloring 

Cells. 

Unit IV 

DHTML and Style Sheets: Defining Styles - Linking a Style Sheet to an HTML 



Document - Inline Styles – Internal Style Sheets - External Style Sheets. Frames: Frameset 

Definition - Frame Definition. 

Unit V 

Forms: Action Attributes - Method Attributes - Enctype Attribute - Drop Down List. 

Text Books: 

1. Xavier, C. (2010). World Wide Web Design with HTML.(23rd edition). New Delhi: TMH 

Publication. 

2. Rizwan Ahmed, P. (2013). Internet and its Application. (2nd edition). Chennai: 

Margham Publications. 

Reference Books: 

1. Paul J. Deitel, Deitel, (2008). Internet & World Wide Web: How to Program. (5th edition). 

Pearson Education. 

2. Raymond Greenlaw, Ellen Hepp. (2007). Fundamentals of Internet and www. (2nd edition). 

New Delhi: Tata Mc GrawHill. 

3. Ivan Bayross. (2010). HTML, DHTML, JavaScript, Perl CGI. (4th edition). BPB 

Publications. 

4. Kogent Learning Solutions Inc., (2012). Web Technologies Black Book. (New Edition). 

New Delhi: Dream Tech Press Publishers. 

5. David Pitt, (2014).Modern Web Essential Javascript & Html5. (2nd edition), New Delhi: 

Infoq Publication 

Semester II 

NME: Desktop Publishing using Scribus 

Course Code: SNM202 

No. of Hours per 

Week 

Credits Total No. of 

Hours 

Marks 

2 2 30 100 

Objectives: 

 

1. To provide information about open source philosophy surrounding scribus and 

understand what scribus can help youdo. 

2. To learn how the different aspects of scribus’s interface can be used to develop all of the 

different document needs that we might have for desktop ppublishing. 

http://www/


 

Course Outcome 

CO Upon completion of this course the students will be able to: 
PSO 

Addressed 
CL 

CO - 1 
use critical thinking skills to independently design and create 

magazines, newsletter, brouchers etc. 
PSO-1 C 

CO - 2 understand the importance of lifelong, student driven learning PSO-2 U 

CO - 3 
know the fundamentals of DTP and easily produce stylised 
documents 

PSO-2 U 

CO - 4 apply major design and marketing concepts to real world projects PSO-4 AP 

 

Unit I 

Scribus Basics: Welcome to Scribus – Download and Installation: GhostScript - Scribus 

1.4.5 –Installation of Scribus on Windows. Before you open Scribus - An introductory tour of the 

Scribus Workspace: Introduction to Frames: Insert Sample Text, Working with Image Frames, 

Creating Inline Characters, Saving a Document, Zoom in on your Documents. Navigating your 

Documents: The Page List, Page Arrows, Document Outline, Switching between Documents, 

Adding and Deleting Pages, Arranging Pages. 

Unit II 

Getting to know the Workspace: The Scribus Workspace: The Menu Bar, The File Menu: 

Preferences, Preferences: The General Tab, The Document Tab, The Fonts Tab, The Guides Tab, 

Grab Radius, The Typography Tab, The Tools Tab, The Scrapbook. The Edit Menu – ThePage 

Menu – The Insert Menu – The Item Menu: The Toolbar – The Properties Palette. 

Unit III 

Text Frames and Font Management: Using Frames– Editing your Text Frames –The 

Story Editor – The Text Tab – Text Wrapping: Flowing Text Around a Quote – TextAlignment – 

kerning and Tracking– Adding a Text FrameBackground – Creating Text over a Semi-transparent 

Background. 

Unit IV 

Working with Graphics: Working with Graphics Files – Working with Image Effects – 

Image Formats. Working with Colors: Choosing Colors: The Color Wheel – Applying Colors – 

Gradients. 

Unit V 

Exporting and Printing your Documents: Copy Editing and Proofreading – Print 



Preview. Automating Scribus: Styles – Master Pages. 

Text Book: 

Robert White. (2015). Beginning Scribus.(3rd edition). New York: Apress Publication. 

 

Reference Books: 

1. Cedric Gemy, (2010). Scribus 1.3.5: Beginner’s Guide. (1st edition). Packt Publishing. 

 

2. Thomas Ecclestone. (2015). Use Scribus: The Desk Top Publishing Program. (1st edition). 

CreateSpace Independent Publishing Platform. 

3. Gregory Pittman, Christoph Schafer, (2009). Scribus: Open Source Desktop Publishing: 

the Official Manual. (reprint edition). FLES Books Publications. 

4. Alice Chen, Gang Chen., (2010 ). Using Free Scribus Software to Create Professional 

Presentations. (New Edition). California: ArchiteG, Inc. Publishers. 

5. John R. Culleton, (2011). Create Book Covers with Scribus 1. 4. 0 and Gimp 2. 6. 11: 

Desktop Guide with Layflat Wire-O Binding. (illustrated edition), Wexford Press 

Publishers. 

 
Semester VI 

Skill Enhancement Course(SEC): Photoshop CS6 

Sub. Code:SSK206 

No. of Hours per 

Week 

Credit Total No. of Hours Marks 

2 2 30 100 

 
Objectives: 

1. To enable students to create images for web design, logos, graphics, layouts, image 

touch- ups and colour enhancement. 

2. To develop the skills for manipulating the images creatively. 

Course Outcome 
 

CO Upon completion of this course the 

students will be able to : 

PSO 
addressed 

CL 

CO -1 Understand retouch and repair a 

scanned photograph. 

PSO –1 AP 



CO -2 Create abilities to use Photoshop that are 

employable and rewarding. 

PSO – 3 C 

CO -3 Understand how to do basic photo repairs and 

color enhancements techniques. 

PSO –1 AP 

CO -4 Define and apply the basic functions of pixel 

selection, painting and editing tools 

PSO - 4 R 

CO -5 Understand file compression, Import and export 

files and save files in different formats 

PSO –1 AN 

CO -6 Utilize retouching features to make 

pictures perfect 

PSO - 1 C 

 

Unit I 

Starting Photoshop CS2 : Getting Started with Photoshop CS2 – Opening an Existing 

File – The Photoshop Program Window – Guidelines for Working with Toolbox – Screen Modes 

– Creating a New File – Saving Files – Removing Files – Closing File. 
 

 

Unit II 

Working with Images: Vector and Bitmap Images – Opening Recently used Files – Image 

Size – Image Resolution – Editing Images – Opening Files Created in Illustrator or Freehand – 

Color Modes – Setting a Current Foreground and Background Colors – File Formats. 

 
Unit III 

Making Selections: Making Selection – The Grow and Similar Commands – Moving a 

Portion of an Image – Editing Selections – Copying a Selection into another Image – Filling a 

Selection – Transforming Selections. 

Unit IV 

Painting, Drawing and Retouching Tools: The painting Tools – The Drawing Tools – 

The Retouching Tools – Layers - Layers Palette – Working with Layers. 

Unit V 

Filters: The Filter Menu – Filter Gallery – Extract Filter – Liquify Filter – Vanishing Point 



Filter – Artistic Filters – Blur Filters – Brush Stroke Filters. 

Text Book: 

Vikas Gupta, (2009). Comdex DTP Course Kit. (2nd edition). New Delhi: Dream Tech 

Press Publications. 

Reference Books: 

1. Martin Evening, (2012). Adobe Photoshop CS6 for Photographers. (2nd edition). New 

Delhi: Elsevier Pvt. Ltd. 

2. Tanya Staples, (2005). Photoshop CS2 for the Web. (2nd edition). New Delhi: Peachpit 

Press. 

3. Taz Tally, (2006). Photoshop CS2 Before and After Makeovers. (2nd edition). New York: 

John Wiley & Sons Publisher. 

4. Philip Andrews, (2005). Adobe Photoshop CS2. (2nd edition). New Delhi: Focal Press. 

5. Kogent Learning, (2012). Photoshop CS2 in Simple Steps. (3rd edition). New Delhi: 

Dreamtech Press. 
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DEPARTMENT OF COMPUTER SCIENCE 

RATIFIED SYLLABUS FOR UNDERGRADUATE PROGRAMME 

(With effect from the Academic year 2021 – 2022) 



 

 

DEPARTMENT OF COMPUTER SCIENCE 
 

 

Vision 

1. To demonstrate proficiency in problem-solving techniques using the computer. 

2. To demonstrate proficiency in at least two high-level programming languages and two 

operating systems 

3. To show the ability to analyze a problem, and identify and define the computing 

requirements appropriate to its solution. 

4. To show the ability to function effectively on teams to accomplish a common goal. 

5. To sensitize the students to the social realities around them with the vision of making them 

responsible citizen. 

Mission 

To provide a high-quality undergraduate education in computer science that prepares 

students for productive careers and lifelong learning. 

 

Programme Educational Objectives (PEOs) 
 

PEO -1 The graduates will apply appropriate theory and scientific knowledge to participate 
in activities that support humanity and economic development nationally and 
globally, developing as leaders in their fields of expertise. 

PEO - 2 The graduates pursue lifelong learning and continuous improvement of the 
knowledge and skills with the highest professional and ethical standards. 

PEO - 3 The graduates are trained to be employed in IT industries by providing domain 
knowledge, career and entrepreneurial skills. 

 

Programme Outcomes (POs) 
 

POs 
Upon completion of B.Sc. Computer Science programme, the graduates will be 

able to: 

PO - 1 utilize scientific knowledge to pursue higher studies in the relevant field. 

PO - 2 
create innovative ideas to enhance entrepreneurial skills for economic 
independence. 

PO – 3 face challenging competitive examinations that offer rewarding careers. 

PO – 4 
reflect upon green initiatives and take responsible steps to build a sustainable 
environment. 

PO – 5 handle ethical issues with social responsibility. 

PO – 6 
communicate effectively and collaborate successfully with peers to become 
competent professionals. 



Programme Specific Outcomes (PSOs) 

 

PSOs Upon completion of the B.Sc. Degree Programme, the graduates will 
be able to: 

PSO – 1 acquire the domain knowledge with critical thinking to serve the technical 
society as software engineer, data analyst and designing professional. 

PSO - 2 enrich the managerial skills through team building and social 
responsibility. 

PSO – 3 enhance the communication skills with lifelong learning. 

PSO - 4 apply modern techniques to sustain the ever-changing era with values. 

 

Eligibility Norms for Admission 

Those who seek admission to B.Sc. Computer Science must have passed the Higher 

Secondary Examinations conducted by the Board of Higher Secondary Examination, Tamil Nadu 

with Computer Science or Mathematics as one of the subjects or any other examination recognized 

and approved by the Syndicate of the Manonmaniam Sundaranar University, Tirunelveli. 

Duration of the Programme:3 years 

Medium of Instruction: English 

Passing Minimum 

A minimum of 40% in the external examination and an aggregate of 40% is required. There 

is no minimum pass mark for the Continuous Internal Assessment. 

Components of the B.Sc. Computer Science Programme 

Part III (Major and Allied) 

 

 
 

Major 

Core – Theory papers 12 x100 1200 

Practical’s (Core applied) 9 x100 900 

Elective - Theory papers 3 x 100 300 

Major Project  100 

Total marks  2500 

 
 

Allied (I & II) 

Theory 4x100 400 

Total marks 
 

400 

 

Part III - Total marks 

 
2900 



Course Structure 
Distribution of Hours and Credits 

Course Sem. 

I 

Sem. II Sem. III Sem. 

IV 

Sem. 

V 

Sem.VI Total 

Hours Credits 

Part I -Language 6 (4) 6 (4) 6(4) 6(4) - - 24 16 

Part II-English 6 (4) 6 (4) 6(4) 6(4) - - 24 16 

Part-III 

Major Core -  Theory 
 

4(4) 

 

4(4) 

4(4)+4(4) 
5(4) 4(4) + 

4(4)+ 

4(4) 

5(4)+ 
4(4)+ 

4(4)+4(4) 

50 48 

Major Core - Practical 
4(2) 4(2) 

3(2) 
2(1) 

4(2) 4(2) 
3(2) 

4(2) 
3(1) 

31 16 

Major Elective - - - 4(3) 4(3) 4(3) 12 9 

Major Project - - - - 5(3)  5 3 

Allied- Theory 4(3) 4(3) 3(3) 3(3) - - 14 12 

Part IV 

Add on Course 

(Professional English) 

2(2) 2(2) 2 (2) 2 (2) - - 8 8 

SEC(Skill 

Enhancement Course) 

2 (2) 2 (2) - -  2 (2) 6 6 

AEC(Ability 

Enhancement Course) 

    2(2)  2 2 

Non-Major Elective 2 (2) 2 (2) - - - - 4 4 

Total 30(23) 30(23) 30(24) 30(22) 30(24) 30(24) 180 140 

Non Academic Courses 

Part V 

*FC –I(Values for 

Life) 

- (1) - - - - - 1 

*FC– II(Personality 

Development) 

- - - 
(1) 

- - - 1 

*FC–III (Human 

Rights Education) 

- - - - (1) - - 1 

*FC –IV (Gender 

Equity Studies) 

- - - - - (1) - 1 

*SLP-Community 

Engagement Course 

- - (2) - - - - 2 

*SLP-Extension 

activity (RUN) 

  
- (2) 

   
2 

*STP - Clubs & 

Committees / NSS 

- - - (2) - - - 2 

Total number of hours = 180      

Total number of credits = 140+10      

Non Academic Courses are Mandatory and conducted outside the regular working hours 

Skill Development Programme (Mandatory Certificate Course- 60 hours) will be offered in 

the first year for all the students. 



Courses Offered 
 

 
Semester 

 
Course 

Course 

Code 
Title of the Course 

Hours 

/ Week 

 

Credits 

 

 

 

 

 

 
I 

Part I TL2012/ 

FL2012 

Language: Tamil/French 6 4 

Part II GE2111 General English 6 4 

 

Part III 

SC2011 Major Core I: Programming Concepts in C 4 4 

SC20P1 Major Practical I: C Programming 4 2 

SA2011 Allied I: Theory: Digital Principles and Applications 4 3 

 
 

Part IV 

APS201 Add on Course: Professional English for Physical 

Sciences – I 

2 2 

SNM201 Non Major Elective (NME): Internet and Web 

Designing with HTML 

2 2 

SEC201 / 

SEC202 

Skill Enhancement Course (SEC): Meditation and 

Exercise / Computer Literacy 

2 2 

 
Part V 

FCV201 Foundation Course I: Values for Life - - 

STP201 Student Training Programme (STP): 

Clubs & Committees / NSS 

- - 

 

 

 

 

 

 

 
II 

Part I TL2022/ 

FL2022 

Language: Tamil/French 6 4 

Part II GE2121 General English 6 4 

 

Part III 

SC2021 Major Core II: Object Oriented Programming Using C++ 4 4 

SC20P2 Major Practical II: C++ Programming 4 2 

SA2021 Allied II: Theory: Computer Organization and 

Architecture 

4 3 

 
 

Part IV 

APS202 Add on Course: Professional English for Physical 

Sciences – II 

2 2 

SNM202 Non Major Elective (NME): Desktop Publishing using 

Scribus 

2 2 

SEC201 / 

SEC202 

Skill Enhancement Course (SEC): Meditation and 

Exercise / Computer Literacy 

2 2 

 

Part V 

FCV201 Foundation Course I: Values for Life - 1 

SLP201 Service Learning Programme: Community Engagement 

Course 

  

STP201 Student Training Programme (STP): Clubs & 

Committees / NSS 

- - 

 

 

 

 

 

 

 

 
III 

Part I TL2031 

FL2031 

Language: Tamil/French 6 4 

Part II GE2131 General English 6 4 

 

 
 

Part III 

SC2131 Major Core III: Programming in Java 4 4 

SC2132 Major Core IV: Data Structures and Algorithms 4 4 

SC21P3 Major Practical III: Java Programming 3 2 

SC21P4 Major Practical IV: Data Structure Using C++ 2 1 

SA2131 Allied III: Theory : Numerical and Statistical Methods 3 3 

Part IV APS203 Add on Course: Professional English for Physical 

Sciences 

2 2 

 
 

Part V 

FCV202 Foundation Course II: Personality Development - - 

STP201 Student Training Programme (STP): Clubs & 

Committees / NSS 

- - 

SLP201 Service Learning Programme (SLP):Community 

Engagement Course 

- 2 



  SLP202 Service Learning Programme (SLP): Extension 

Activity (RUN) 

- - 

 

 

 

 

 

 

 

 
IV 

Part I TL2041 

FL2041 

Language: Tamil/French 6 4 

Part II GE2141 General English 6 4 

 

 

Part III 

SC2141 Major Core V: UNIX and Shell Programming 5 4 

 

SC2142 

SC2143 

SC2144 

Major Elective I: 

(a) Software Engineering 
(b) System Administration and Maintenance 
(c) Software Testing 

 
 

4 

 
 

3 

SC21P5 Major Practical V: Shell Programming 4 2 

SA2141 Allied IV: Theory: Discrete Mathematics 3 3 

Part IV APS204 Add on Course: Professional English for Physical 
sciences 

2 2 

 
Part V 

FCV202 Foundation Course II: Personality Development - 1 

SLP202 
Service Learning Programme (SLP) Extension Activity 
(RUN) 

- 2 

STP201 
Student Training Programme (STP): Clubs & 
Committees / NSS 

- 2 

 

 

 

 

 

V 

 

 

 

Part III 

SC2151 Major Core VI: Web Technology: Theory and Practice 4 4 

SC2152 Major Core VII: Relational Database Management 
Systems 

4 4 

SC2153 Major Core VIII: Mobile Computing and its Applications 4 4 

 

SC2154 

SC2155 

 
SC2156 

Major Elective II: 

(a) Multimedia Systems 

(b) Microprocessor & Assembly Language 

Programming 
(c) Open Source Technology 

 
 

4 

 
 

3 

SC21P6 Major Practical VI: Web Technology Lab 4 2 

SC21P7 Major Practical VII: SQL and PLSQL 3 2 

SC21PR Major Project 5 3 

Part IV 
AEC201 

Ability Enhancement Course (AEC): 
Environmental Studies 

2 2 

Part V FCV203 Foundation Course III: Human Rights Education 
- 1 

 

 

 

 

 

 

VI 

 

 

 
 

Part III 

SC2161 Major Core IX: Android Programming 5 4 

SC2162 Major Core X: Computer Graphics 4 4 

SC2163 Major Core XI: Operating Systems: Design Principles 4 4 

SC2164 Major Core XII: Computer Networks 4 4 

 

SC2165 

SC2166 

SC2167 

Major Elective III: 

(a) PHP Programming 
(b) Network Security 
(c) E-Commerce Technologies 

 
 

4 

 
 

3 

SC21P8 Major Practical VIII: Android Programming Lab 4 2 

SC21P9 Major Practical IX: Computer Graphics Lab 3 1 

Part IV 
SSK206 Skill Enhancement Course (*SEC): Photoshop CS6 2 2 

Part V FCV204 Foundation Course IV: Gender Equity Studies (GES) - 1 

   TOTAL 180 140+ 

10 



*SBC for the VI semester is offered by the departments for their students 

SBC - We offer PHP Programming during VI semester. The objective of this SBC is to 

develop webpage. 

NMEC – We offer Internet and Web Designing with HTML and Desktop Publishing using 

Scribus during I and II semester. The objective of Internet and Web Designing with HTML is to 

design webpage and browse in internet and Desktop Publishing using Scribus to design and create 

magazines, newsletter, brouchers etc and to easily produce stylised documents. Project – We 

offer project in V semester. The aim is to equip the students to develop real time projects. 

Self-Learning – Extra Credit Courses 

 

Semester Course Code Title of the Course Hours / 

Week 

Credits 

III SC20S1 Web Designing with HTML - 2 

IV SC20S2 Maya - 2 

 

Value Added Courses 
 

Semester Course Code Title of the course Total hours 

I VASC201 DCA-I 30 

II VASC202 DCA-II 30 

 
Instruction for Course Transaction 

Distribution of total hours for Theory (Major Core) 

Components Sem I Sem II Sem III Sem IV Sem V Sem 

VI 

Lecture Hours 45 45 45 60 45 45/60 

Continuous Internal 

Assessment (2) 

5 5 5 5 5 5 

Quiz(2) 1 1 1 1 1 1 

Class test(3) 3 3 3 3 3 3 

* Class assignment/Group 

discussion/ Problem 

Solving(any other) 

 
6 

 
6 

 
6 

 
6 

 
6 

 
6 

Total Hours 60 60 60 75 60 60/75 



Distribution of total hours for Theory (Elective / Allied) 

Components Elective Allied 

Sem IV Sem V Sem VI Sem I Sem II Sem III Sem IV 

Lecture Hours 45 45 45 45 45 30 30 

Continuous Internal 

Assessment(2) 

5 5 5 5 5 5 5 

Quiz(2) 1 1 1 1 1 1 1 

Class test(3) 3 3 3 3 3 3 3 

* Class assignment/Group 

discussion/ Problem 

Solving(any other) 

 
 

6 

 
 

6 

 
 

6 

 
 

6 

 
 

6 

 
 

6 

 
 

6 

Total Hours 60 60 60 60 60 45 45 

 
Distribution of total hours for Practical 

 

 
Semester Hours / Week Total Hours / 

   Semester 

 

Major 
I /II 4/4 120 

III 3 75 

  2  

 
IV 4 60 

 
V 4 180 

  3  

  5  

 
VI 4 105 

  3  



Examination Pattern Ratio of Internal and External Components 

 

Each paper carries an internal component. • 

There is a passing minimum for external component. 

A minimum of 40% in the external examination and an aggregate of 40% is required. 

 
i) a. Part I - Tamil 

Ratio of Internal and External= 30:70 

Continuous Internal Assessment (CIA) 
Internal Components and Distribution of Marks 

 

Components Marks 

Internal test (2) 15 

Quiz (2) 4 

Class Test (2) 6 

Class assignment/ Home assignment/ Field assignment/ Article 

review/ Group discussion/ Problem solving 

5 

Total 30 

 

Question Pattern 
 

Internal Test Marks External Exam Marks 

Part A 4 x 1 4 Part A 10 x 1 (No choice) 10 

Part B 3 x 4 12 Part B 5 x 4 (Internal choice) 20 

Part C 3 x 8 24 Part C 5 x 8 (Internal choice) 40 

Total 40 Total 70 

 
b. Part I -French 

Ratio of Internal and External= 30:70 

 

Continuous Internal Assessment (CIA) 
Internal Components and Distribution of Marks 

 

Components Marks 

Internal test (2) 15 

Quiz (2) 4 

Class Test (2) 6 

Class assignment/ Home assignment/ Field assignment/ Article 

review/ Group discussion/ Problem solving 

5 

Total 30 

 

Question Pattern for I & II Semesters 
 

Internal Test Marks External Exam Marks 

Part A (Translation) 5 Part A (Translation) 4x5 20 

Part B (Grammar) 5x5 25 Part B (Grammar) 6x5 

(Paragraph Writing) 15x1 

30 



Part C (Paragraph 

Writing)10x1 

10 Part C (Translation, Comprehension) 

2x5 

 

10 

  Part D 5x2 10 

Total 40 Total 70 
 

ii) Part II - General English 

Ratio of Internal and External= 30:70 

 
Continuous Internal Assessment (CIA) 

Internal Components and Distribution of Marks 

 

Components Marks 

Internal test (2) 15 

Quiz (2) 4 

Class Test (3) 6 

GD/Open Book Test/Role Play/Assignment/Article 

Review/Seminar 
5 

Total 30 

 

Question Pattern 
Internal Test Marks External Exam Marks 

Part A (Objective Type) 4 x 1 = 4 Part A (Objective Type) 10 x 1 = 10 

Part B 3 x 4 = 12 Part B 5 x 4 = 20 

Part C 3 x 8 = 24 Part C 5 x 8 = 40 

Total 40 Total 70 

 

iii) Part III (Major/ Elective/ Allied) 

Ratio of Internal and External= 30:70 

 

Continuous Internal Assessment (CIA) 
Internal Components and Distribution of Marks 

 

Internal Components Marks 

Internal test (2) 15 

Quiz (2) 4 

Class test (3) 6 

Open Book Test/ Home 

assignment / Class Assignment/ 

Group Discussion 

5 

Total 30 



Question Pattern 
 

Internal Test Marks External Exam Marks 

Part A 4 x 1 4 Part A 10 x 1 (No choice) 10 

Part B 3 x 4 12 Part B 5 x 4  (Internal choice) 20 

Part C 3 x 8 24 Part C 5 x 8  (Internal choice) 40 

Total 40 Total 70 

 
 

Practical’s: Major Core & Allied papers 

Ratio of Internal and External= 40:60 

Total: 100 marks 

Internal Components and Distribution of Marks 
 

Internal Components Marks 

Performance of the Experiments 10 

Regularity in attending practical and submission of records 10 

Record 5 

Model exam 15 

Total 40 

 

Question pattern 
 

External Exam Marks 

Major Practical 
60 

Minor Practical / Spotters /Record 

Total 60 

 
iv) Part IV 

Ratio of Internal and External = 50: 50 

a) Add-on Course: Professional English for Physical Sciences 

Internal Components and Distribution of Marks 
 

Internal Components Marks 

Listening and speaking 25 

Reading and Writing 25 

Total 50 

 

Question pattern 
 

External Exam Marks 

Written Test : Open choice – 5 out of 7 questions (5 x 10) 50 

Total 50 



b) Non – Major Elective (NME) 

Continuous Internal Assessment (CIA) 
Internal Components and Distribution of Marks 

 

Internal Components Marks 

Internal test (2) 20 

Quiz (2) 15 

Class assignment/ Home assignment/ Project report 15 

Total 50 

 
Question Pattern 

 

Internal Test Marks External Exam Marks 

Part A 4 x 1 

(No Choice) 

4 Part A 5 x 1 

(No Choice) 

5 

Part B 3 x 4 
(Internal Choice) 

12 Part B 5 x 3 
(Internal Choice) 

15 

Part C 3 x 8 

(Internal Choice) 

24 Part C 5 x 6 

(Internal Choice) 

30 

Total 40 Total 50 

 
 

c) Skill Enhancement Course (SEC) - Computer Literacy 

Internal Components 
 

Component Marks 

Objective type questions (30x1) 30 

Exercise (Book) compulsory (2x10) 20 

Total 50 

 

External Components 
 

Component Marks 

Exercise 1 20 

Exercise 2 10 

Procedures for both Exercises 20 

Total 50 

 
d) Skill Enhancement Course (SEC) - Meditation and Exercise 

Internal Components 
 

Component Marks 

Objective type questions (20x1) 20 

Exercise (2x10) 20 

Assignment 10 

Total 50 



External Components 
 

Component Marks 

Quiz 20 

Written test : Open choice –10 out of 15 questions (10x3) 30 

Total 50 

 
 

e) Ability Enhancement Course (AEC) - Environmental Studies 

Internal Components 
 

Component Marks 

Project Report 30 

Viva voce 20 

Total 50 

 

 
External Components 

 

Component Marks 

Quiz 20 

Written Test : Open choice – 10 out of 15 questions (10x3) 30 

Total 50 

 
v) Part V 

i) Foundation course (Values for life, Personality development, Human rights 

education and Gender equity studies) 

Ratio of Internal and External = 50: 50 

 
 

a) Foundation Course I: Values for Life 

Internal Components 

Component Marks 

Song, Mime, Skit 20 

Book Activities 20 

A Kind Action 10 

Total 50 

External Components 

Component Marks 

Quiz 20 

Written Test : Open choice – 5 out of 7 questions (5 x 6) 30 

Total 50 



b) Foundation Course II: Personality Development 

Internal Components 

Component Marks 

Exercise from book 20 

Skit 10 

Group Album 20 

Total 50 

 

External Components 

Component Marks 

Quiz 20 

Written Test : Open choice – 5 out of 7 questions (5 x 6) 30 

Total 50 

 

c) Foundation Course III: Human Rights Education 

Internal Components 

Component Marks 

Album on current issues 20 

Group Song/ Mime/ Skit 10 

Open book test (Objective type questions) 20 

Total 50 

External Components 

Component Marks 

Quiz 20 

Written Test : Open choice – 5 out of 7 questions (5 x 6) 30 

Total 50 

d) Foundation Course IV: Gender Equity Studies 

Internal Components 

Component Marks 

Album on current issues 20 

Group Song/ Mime/ Skit 10 

Open book test (Objective type questions) 20 

Total 50 

External Components 

Component Marks 

Quiz 20 

Written Test : Open choice – 5 out of 7 questions (5 x 6) 30 

Total 50 



e) SLP -Community Engagement Course (CEC) 

(Field Work – 15 hrs; Class Hours – 15 hrs) 

Internal Components 

Component Marks 

Assignment 10 

Group Discussion 10 

Attendance (Field work) 30 

Total 50 

External Components 

Component Marks 

Project Report / Case Study (10-15 pages in print) 

Group project 

50 

Total 50 

f) SLP – Service Learning Programme: Reaching the Unreached Neighborhood (RUN) 

• 60 Hours mandatory programme included in the curriculum (2 credits). 

 
g) STP – Student Training Programme 

• Compulsory for all I &II year students (2 credits). 

• Clubs and Committees – Eco Club, YRC, Rotaract Club, NSS/ RRC, 

AICUF, Consumer Club, Sports, Legal Literacy and Women’s Cell. 

• Each student can opt for one club/ committee. 

 

 

Semester I 

NME: Internet and Web Designing with HTML 

Course Code: SNM201 

 

Hours/Week 
Credits 

Total Hours 
Marks 

2 2 30 100 

Objectives: 

1. To enable the students to specify design rules in constructing web pages and sites. 

2. To enable the students to learn the basic working scheme of the Internet and World Wide Web. 

 

Course Outcome 
 

CO Upon completion of this course the students will be able 

to: 

PSO 

Addressed 
CL 

CO - 1 analyze a web page and identify its elements and attributes. PSO-1 AN 

CO - 2 
design web pages using DHTML and Cascading Style 

Sheets. 

PSO-2 C 

CO - 3 design and construct web sites. PSO-4 C 

CO – 4 create e-mail ID and browse in internet. PSO-4 AP, C 



 

 

 
 
 

Unit I 

Introduction to Internet: Internet –World Wide Web - Web Browsers. E-mail: E-mail - 

Creating an E-mail id - Sending and Receiving mails – Attaching a File – Functions of e-mail – 

Advantages and Disadvantages of e-mail. 

Unit II 

Introduction to HTML: Designing a Home Page - HTML Documents - Anchor Tag. 

Head and Body Section: Colorful Web Page. Designing the Body Section: Horizontal Rule – 

Aligning the Headings - Image and Pictures. 

Unit III 

Ordered and Unordered lists: List - Unordered lists - Ordered Lists - Nested Lists. Table 

Handling: Tables - Table Creation in HTML - Cells Spanning Multiple Rows/ Columns - Coloring 

Cells. 

Unit IV 

DHTML and Style Sheets: Defining Styles - Linking a Style Sheet to an HTML 

Document - Inline Styles – Internal Style Sheets - External Style Sheets. Frames: Frameset 

Definition - Frame Definition. 

Unit V 

Forms: Action Attributes - Method Attributes - Enctype Attribute - Drop Down List. 

Text Books: 

1. Xavier, C. (2010). World Wide Web Design with HTML.(23rd edition). New Delhi: TMH 

Publication. 

2. Rizwan Ahmed, P. (2013). Internet and its Application. (2nd edition). Chennai: Margham 

Publications. 

Reference Books: 

1. Paul J. Deitel, Deitel, (2008). Internet & World Wide Web: How to Program. (5th edition). 

Pearson Education. 

2. Raymond Greenlaw, Ellen Hepp. (2007). Fundamentals of Internet and www. (2nd edition). 

New Delhi: Tata McGrawHill. 

3. Ivan Bayross. (2010). HTML, DHTML, JavaScript, Perl CGI. (4th edition). BPB 

Publications. 

4. Kogent Learning Solutions Inc., (2012). Web Technologies Black Book. (New Edition). 

http://www/


New Delhi: DreamTech Press Publishers. 

5. David Pitt, (2014).Modern Web Essential Javascript & Html5. (2nd edition), New Delhi: 

Infoq Publication. 

 

 

 
Semester II 

NME: Desktop Publishing using Scribus 

Course Code: SNM202 

Hours/Week Credits Total Hours Marks 

2 2 30 100 

Objectives: 

 

1. To provide information about open source philosophy surrounding scribus and 

understand what scribus can help you do. 

2. To learn how the different aspects of scribus’s interface can be used to develop all of the 

different document needs that we might have for desktop publishing. 

 
Course Outcome 

CO Upon completion of this course the students will be able 

to: 

PSO 

Addressed 
CL 

CO - 1 
use critical thinking skills to independently design and 
create 

magazines, newsletter, brouchers etc. 

PSO-1 C 

CO - 2 understand the importance of lifelong, student driven 

learning 

PSO-2 U 

CO - 3 
know the fundamentals of DTP and easily produce stylised 
documents 

PSO-2 U 

CO - 4 apply major design and marketing concepts to real world 
projects 

PSO-4 AP 

Unit I 

Scribus Basics: Welcome to Scribus – Download and Installation: GhostScript - Scribus 

1.4.5 –Installation of Scribus on Windows. Before you open Scribus - An introductory tour of the 

Scribus Workspace: Introduction to Frames: Insert Sample Text, Working with Image Frames, 

Creating Inline Characters, Saving a Document, Zoom in on your Documents. Navigating your 

Documents: The Page List, Page Arrows, Document Outline, Switching between Documents, 

Adding and Deleting Pages, Arranging Pages. 



 

 

 

Unit II 

Getting to know the Workspace: The Scribus Workspace: The Menu Bar, The File Menu: 

Preferences, Preferences: The General Tab, The Document Tab, The Fonts Tab, The Guides Tab, 

Grab Radius, The Typography Tab, The Tools Tab, The Scrapbook. The Edit Menu – ThePage 

Menu – The Insert Menu – The Item Menu: The Toolbar – The Properties Palette. 

Unit III 

Text Frames and Font Management: Using Frames– Editing your Text Frames –The 

Story Editor – The Text Tab – Text Wrapping: Flowing Text Around a Quote – Text Alignment – 

kerning and Tracking– Adding a Text Frame Background – Creating Text over a Semi-transparent 

Background. 

Unit IV 
 

Working with Graphics: Working with Graphics Files – Working with Image Effects – 

Image Formats. Working with Colors: Choosing Colors: The Color Wheel – Applying Colors – 

Gradients. 

Unit V 

Exporting and Printing your Documents: Copy Editing and Proofreading – Print 

Preview. Automating Scribus: Styles – Master Pages. 

Text Book: 

Robert White. (2015). Beginning Scribus. (3rd edition). New York: Apress Publication. 

 

Reference Books: 

1. Cedric Gemy, (2010). Scribus 1.3.5: Beginner’s Guide. (1st edition). Packet Publishing. 

 

2. Thomas Ecclestone. (2015). Use Scribus: The Desk Top Publishing Program. (1st edition). 

CreateSpace Independent Publishing Platform. 

3. Gregory Pittman, Christoph Schafer, (2009). Scribus: Open Source Desktop Publishing: 

the Official Manual. (reprint edition). FLES BooksPublications. 

4. Alice Chen, Gang Chen., (2010 ). Using Free Scribus Software to Create Professional 

Presentations. (New Edition). California: ArchiteG, Inc.Publishers. 

5. John R. Culleton, (2011). Create Book Covers with Scribus 1. 4. 0 and Gimp 2. 6. 11: 

Desktop Guide with Layflat Wire-O Binding. (illustrated edition), Wexford Press 

Publishers. 



Semester IV 

Major Elective I: (a) Software Engineering 

Course Code: SC2142 
 

Hours / Week Credits Total Hours Marks 

4 3 60 100 

 
Objectives: 

1. To understand the software engineering concepts. 

2. Understand the coding, testing and user interface design 

3. Design, develop the software projects and software reliability and quality management 

 
Course Outcome 

 

CO Upon completion of this course the students 

will be able to : 

PSO 
addressed 

CL 

CO -1 apply software engineering principles and techniques PSO – 1  
AP 

CO -2 develop, maintain and evaluate large-scale software 

systems. 

PSO – 4  

C 

CO -3 produce efficient, reliable, robust and cost-effective 

software solutions. 

PSO - 4  

C 

CO -4 ability to work as an effective member or leader of 

software engineering teams. 

PSO – 2  

AP 

CO -5 ability to manage time, processes and resources 

effectively by prioritising competing demands to 

achieve personal and team goals 

PSO – 2  

U 

 

Unit I 

Introduction - Software Engineering Discipline - Evolution and Impact - Programs Vs 

Software Products. Software Life Cycle Models: Classical Waterfall Model -Iterative Waterfall 

Model - Prototyping Model - Evolutionary Model - Spiral Model. Software Project Management: 

Responsibilities of a Software Project Manager - Project Planning - Risk Management. 

Unit II 

Requirements Analysis and Specification: Requirements Gathering and Analysis - 

Software Requirements Specification (SRS): Users of SRS Document, Characteristics of a Good 

SRS Document, Attributes of Bad SRS Documents –Software Design: Characteristics of a Good 

Software Design - Cohesion and Coupling. 



Unit III 

Function-Oriented Software Design: Overview of SA/SD Methodology - Structured 

Analysis - Data Flow Diagrams (DFDs).Object Modeling Using UML: - UML Diagrams - Use 

Case Model: Representation of Use Cases. Why Develop Use Case Diagram, how to identify the 

Use Cases of a system - Class Diagrams - Interaction Diagrams - State Chart Diagram. 

Unit IV 

User Interface Design: Characteristics of a Good User Interface - Basic Concepts - Types 

of User Interfaces - Coding and Testing: Coding – Testing: Basic Concepts and Terminologies, 

Testing Activities -NIT Testing - Black-Box Testing - White-Box Testing - Debugging - 

Integration Testing. 

 

Unit V 

Software Reliability and Quality Management: Software Reliability - Statistical Testing 

-Software Quality - Software Quality Management System - ISO 9000:What is ISO 9000 

Certification, ISO 9000 for Software Industry-Computer Aided Software Engineering: CASE 

Environment - CASE support in Software Life Cycle - Characteristics of CASE Tools - Software 

Maintenance: Characteristics of Software Maintenance - Software Reverse Engineering - 

Software Maintenance Process Models. 

Text Book: 

Rajib Mall, "Fundamentals of Software Engineering",3rd Edition, Prentice Hall of India 

Private Limited, 2008. 

Reference Books: 

1. Rajib Mall, "Fundamentals of Software Engineering", 4thEdition, Prentice Hall of India 

Private Limited, 2014. 

2. Richard Fairley, "Software Engineering Concepts", TMGH Publications, 2004. 



Semester V 

Major Core VI: Web Technology: Theory and Practice 

Course Code: SC2151 

Hours / Week Credits Total Hours Marks 

4 4 60 100 

 

Objectives: 

1. To study the various HTML tags and design simple web pages 

2. To study the scripting language Java Script. 

 
Course Outcome 

 

CO Upon completion of this course the students 

will be able to : 

PSO 
addressed 

CL 

CO -1 develop an ability to design and implement static and 

dynamic web pages. 

PSO – 1 C 

CO -2 differentiate web applications using client-side 

(JavaScript, HTML, XML) and server-side 

technologies (ASP.NET, ADO.NET). 

PSO –1 AN 

CO -3 define the fundamental ideas and standards 

underlying Web Service Technology 

PSO – 1 U 

CO -4 apply the knowledge of the internet and related internet 

concepts that are vital in understanding web 

application development and analyze the insights of 

internet programming to implement complete 

application over the web. 

PSO –3 AP 



 

Unit I 

Structuring Documents for the Web: Introducing HTML and XHTML - Basic Text 

Formatting - Presentational Elements–Phrase Elements - Lists - Core Elements and Attributes. 

Links and Navigation: Basic Links - Creating Links with the <a> Element. Images, Audio, and 

Video: Adding Images Using the <img> Element - Using Images as Links. 

 

Unit II 

Images, Audio, and Video: Adding Flash, Video and Audio to your web pages: Adding 

videos to your Site, Adding Audio to your Site. Tables: Basic Table Elements and Attributes – 

Adding a <caption> to a Table - Grouping Section of a Table - Nested Tables. Forms: Introducing 

Forms - Form Controls - Sending Form Data to the Server. 

Unit III 

Frames: Introducing Frameset – The <frameset> Element–The <frame> Element - 

Creating Links Between Frames - Nested Framesets. Cascading Style Sheets: Introducing CSS - 

Where you can Add CSS Rules - Controlling Text - Text Formatting - Text Pseudo Classes. 

Unit IV 

Java Script: How to Add Script to Your Pages – Variables–Operators –Control Structures 

- Conditional Statements – Looping – Functions – Built in Functions. Working with JavaScript: 

Practical Tips for Writing Scripts. 

Unit V 

JavaScript Objects: Window Object - Document object - Browser Object - Form Object 

- Navigator object - Screen object – Events - Event Handlers – Forms Validations. 

Text Book: 

Jon Duckett, “Beginning HTML, XHTML, CSS and Java Script”, Second Edition, Wiley 

Publishing, 2010. 

Reference Books: 

1. Chris Bates, “ Web Programming”, Third Edition, Wiley Publishing, 2014 

2. Srinivasan. M, “Web Technology: Theory and Practice”, Pearson Publication 



 

 

 

Semester VI 

Skill Enhancement Course(SEC): Photoshop CS6 

Course Code: SSK206 

Hours /Week Credits Total Hours Marks 

2 2 30 100 

 
Objectives: 

1. To enable students to create images for web design, logos, graphics, layouts, image touch- 

ups and colour enhancement. 

2. To develop the skills for manipulating the images creatively. 

Course Outcome 
 

CO Upon completion of this course the 

students will be able to : 

PSO 
addressed 

CL 

CO -1 understand retouch and repair a scanned 

photograph. 

PSO –1 AP 

CO -2 create abilities to use Photoshop that are 

employable and rewarding. 

PSO – 3 C 

CO -3 understand how to do basic photo repairs and 

color enhancements techniques. 

PSO –1 AP 

CO -4 define and apply the basic functions of pixel 

selection, painting and editing tools 

PSO - 4 R 

CO -5 understand file compression, Import and export 

files and save files in different formats 

PSO –1 AN 

CO -6 utilize retouching features to make pictures 

perfect 

PSO - 1 C 

 

Unit I 

Starting Photoshop CS2 : Getting Started with Photoshop CS2 – Opening an Existing 

File – The Photoshop Program Window – Guidelines for Working with Toolbox – Screen Modes 

– Creating a New File – Saving Files – Removing Files – Closing File. 



Unit II 

Working with Images: Vector and Bitmap Images – Opening Recently used Files – Image 

Size – Image Resolution – Editing Images – Opening Files Created in Illustrator or Freehand – 

Color Modes – Setting a Current Foreground and Background Colors – File Formats. 

 
Unit III 

Making Selections: Making Selection – The Grow and Similar Commands – Moving a 

Portion of an Image – Editing Selections – Copying a Selection into another Image – Filling a 

Selection – Transforming Selections. 

Unit IV 

Painting, Drawing and Retouching Tools: The painting Tools – The Drawing Tools – 

The Retouching Tools – Layers - Layers Palette – Working with Layers. 

Unit V 

Filters: The Filter Menu – Filter Gallery – Extract Filter – Liquify Filter – Vanishing Point 

Filter – Artistic Filters – Blur Filters – Brush Stroke Filters. 

Text Book: 

Vikas Gupta, (2009). Comdex DTP Course Kit.(2nd edition). New Delhi: DreamTech Press 

Publications. 

Reference Books: 

1. Martin Evening, (2012). Adobe Photoshop CS6 for Photographers. (2nd edition). New 

Delhi: Elsevier Pvt. Ltd. 

2. Tanya Staples, (2005). Photoshop CS2 for the Web. (2nd edition). New Delhi: Peachpit 

Press. 

3. Taz Tally, (2006). Photoshop CS2 Before and After Makeovers. (2nd edition). New York: 

John Wiley & Sons Publisher. 

4. Philip Andrews, (2005). Adobe Photoshop CS2. (2nd edition). New Delhi: Focal Press. 

5. Kogent Learning, (2012). Photoshop CS2 in Simple Steps. (3rd edition). New Delhi: 

Dreamtech Press. 

 

 

Professional Ethics 


